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Preface    

Preface

This reference guide contains detailed information on the use of the Pocket PC powered with the
Microsoft® Windows® Powered Pocket PC 2002.

The guide is organised as follows.

Chapter 1 — Get Started, provides procedures for unpacking, battery installing, battery
charging, calibration, and installing Microsoft ActiveSync®.

Chapter 2 — Learn the Basics, includes information on pop-up menus, notifications, and
entering information. Also includes information for customising your Pocket PC.

Chapter 3 — Use Microsoft Pocket Outlook, provides procedures for using Microsoft Pocket
Outlook Calendar, Contacts, Tasks, Notes, and Inbox.

Chapter 4 — Use the Companion Programs, includes information on using Pocket Word,
Pocket Excel, MSN Messenger, Windows Media™ Player for Pocket PC, and Microsoft Reader.

Chapter 5 — Use Pocket Internet Explorer, provides information and procedures for using
Pocket Internet Explorer, Mobile Favourites folder, and AvantGo interactive service.

Chapter 6 — Get Connected, includes procedures for connecting to the Internet and for
transferring data using infrared.

Chapter 7 — If You Have Problems, includes information for solving problems that you might
have in using the Pocket PC.

Chapter 8 — Specifications, includes specifications for the Pocket PC and its accessories.
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This chapter includes the following information:

 unpacking your Pocket PC

 getting to know your Pocket PC

 installing and charging the battery

 calibrating and activating the Pocket PC

 learning the basics

 installing Microsoft® ActiveSync®.

Unpack Your Pocket PC
Your Pocket PC ships with a number of accessories. When you unpack the Pocket PC, verify
that you have all of the items listed here and that they are in good condition. If anything is
missing or damaged, contact the organisation that sold you the Pocket PC.

Note   Before you start using your Pocket PC for the first time, you need to install and charge
the battery (see “Install and Charge the Battery” later in this chapter).

 Pocket PC (includes a stylus in a holder on the Pocket PC)

 Pocket PC AC Adapter

 Pocket PC European Converter and UK Converter (for the AC Adapter)

 Pocket PC Battery

 Pocket PC Universal Serial Bus (USB) Cradle (includes an extra stylus)

 Companion CD (contains the Microsoft ActiveSync software and your documentation)

 Pocket PC Getting Started Guide

 Pocket PC Reference Guide (on the Companion CD)

 Pocket PC Release Notes (optional)
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Get to Know Your Pocket PC
Your Pocket PC is a multifunction handheld device designed for ease of use in the office, on the
road, at home, or wherever you are.

The Pocket PC is powered by the Microsoft Windows Powered Pocket PC 2002 operating
system. Data synchronising between the Pocket PC and any other computer is provided by
Microsoft ActiveSync.

Standard features include a 206-MHz Intel® Strong ARM processor, 64-MB synchronous
dynamic random access memory (SDRAM) , reflective LCD panel with 64K colour, touch
screen with automatic backlighting, internal speaker, microphone, and a rechargeable Lithium
Ion battery. Touch screen backlighting and brightness levels are adjustable.

The Pocket PC includes an infrared (IR) port and Secure Digital (SD) card slot. You can use the
IR port to transfer data between other handheld devices with IR capabilities or your computer.
The SD card slot can be used to expand memory, add applications, and more.

Also included with the Pocket PC is a cradle for holding the Pocket PC and an AC adapter. Use
the cradle to charge the battery and to synchronise with your computer.

Your Pocket PC comes with a stylus, a pen-like device that allows you to touch or tap objects on
the Pocket PC touch screen. The touch, tap, and double tap act just like a point, click, and double
click of a mouse.

The external features of the Pocket PC and cradle are shown and described in the following
sections.
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Front Features
The front features of the Pocket PC are shown in the following figure. Brief descriptions follow
the figure.

Pocket PC Front Features

A – Touch Screen F – Calendar Button
B – Notes Button G – Tasks Button
C – Speaker H – Battery Charging LED
D – Contacts Button  I –Notification LED
E – Navigation Button (4)

 Touch Screen — enter, read, send, receive, and modify data by tapping the touch screen
with the stylus. Backlighting is automatic with automatic dimming after a preset time. Tap
the touch screen to restore full backlighting.

 Battery Charging LED — lights amber while the battery is charging. The light goes off
when the battery is charged.

 Notification LED — blinks red to indicate an alarm or reminder.

 Program Buttons — press or tap the Notes, Calendar, Contacts, or Tasks button for quick
access to tasks or programs. The buttons are customisable.

 Navigation Buttons — use the four buttons as arrow keys, the same as you would for a
keyboard’s up, down, left, and right arrow keys.

 Speaker — sounds alarms and plays back sound recordings.
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Back Features
The back features of the Pocket PC are shown in the following figure. Brief descriptions follow
the figure.

Pocket PC Back Features

A – Expansion Jacket Guider C – Battery Lock
B – Expansion Connector D – Battery

 Expansion Jacket Guider — secures an optional CompactFlash (CF)/PC Card expansion
jacket to your Pocket PC.

 Expansion Jacket Connector — connect an optional CF/PC Card expansion jacket to this
connector for adding functionality.

 Battery Lock — secures the battery.

 Battery — supplies power to your Pocket PC. You can recharge the battery by connecting to
AC power.
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Right Side Features
The right side features of the Pocket PC are shown in the following figure. Brief descriptions
follow the figure.

Pocket PC Right Side Features

A – Stylus B – Power Connector

 Stylus — use to tap or write on the screen. Slide the stylus out of its storage compartment
on your Pocket PC.

Always use the stylus for tapping the touch screen. Never use hard-
pointed or sharp objects. These objects can damage the touch screen.

 Power Connector — connect the AC adapter to this connector if you are not using the
cradle.
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Left Side Features
The left side features of the Pocket PC are shown in the following figure. Brief descriptions
follow the figure.

Pocket PC Left Side Features

A – Scroll Dial C – Reset Button
B – Recording Button

 Scroll Dial — use to scroll through a menu and to select a program.

 Recording Button — records sound in a program where you can include a recording (see
“Record a Message” in Chapter 2).

 Reset Button — performs a soft reset of the operating system in case of malfunction. Your
data is preserved if it was saved.
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Top Features
The top features are shown in the following figure. Brief descriptions follow the figure.

Pocket PC Top Features

A – Headset Jack Port D – Microphone
B – IR Port E – Secure Digital Card Slot
C – Power Button

 Headset Jack Port — connect an optional headset to this port.

 Infrared (IR) Port — exchange data with another handheld or your computer (both must
have IR capabilities).

 Power Button — turns power on and off. The Pocket PC automatically turns off after one
minute of inactivity to conserve battery power. The inactivity setting is adjustable.

 Microphone — records your notes.

 Secure Digital (SD) Card Slot — holds an SD card. Insert an SD card in this slot to load
programs into your Pocket PC. You can also use optional SD cards to add graphics,
databases, and other information to your Pocket PC.

Bottom Features
The bottom features are shown in the following figure. Brief descriptions follow the figure.

Pocket PC Bottom Features

A – Cradle Connector

 Cradle Connector — connect the cradle to this connector. Use the cradle to charge the
battery and to synchronise the Pocket PC with your computer.
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Cradle Features
The cradle holds the Pocket PC for charging the battery, synchronising data with your desktop
computer, using optional expansion cards or if you keep your Pocket PC on for long periods.
You can also charge the Pocket PC without using the cradle.

Use the AC adapter when you recharge the battery, use expansion cards, or if you keep your
Pocket PC on for long periods.

The cradle features are shown in the following figure. Brief descriptions follow the figure.

Pocket PC Cradle Features

A – Battery Charging LED (on front) D – Power Connector
B – Stylus E – USB Cable
C – Pocket PC Connector F – Battery Connector

 Battery Charging LED — lights amber while the battery is charging. The light goes off
when the battery is charged.

 Stylus — use this extra stylus if you are not using the one on your Pocket PC.

 Pocket PC Connector — connect your Pocket PC to this connector. Use the cradle to charge
the battery and to synchronise the Pocket PC with your computer.

 Power Connector — connect the AC adapter to this connector.

 USB Cable — connect the USB cable to the USB port on your computer for synchronising
data.

 Battery Connector — connect an optional extra battery to this connector. Use the cradle to
charge the extra battery.
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Install and Charge the Battery
Your Pocket PC contains a rechargeable Lithium Ion battery. The battery must be installed and
charged before you use the Pocket PC the first time. You can periodically recharged thereafter.
As the battery is rechargeable, you do not need to constantly change batteries.

Install the Battery
1. Slide the battery lock on the back of your Pocket PC to the left.

2. Insert the battery’s two small tabs into the corresponding holes on your Pocket PC at an
angle and then fit the battery into place.

3. Slide the battery lock to the right to secure the battery.

Charge the Battery
Battery power is monitored by your Pocket PC. Warning messages and battery low icons display
when battery power becomes low. If you receive a “battery low” warning message, you should
save your data and recharge the battery as soon as possible to avoid data loss.



Get Started  1-11

You can also monitor battery power activity through the “power remaining” indicator on your
Pocket PC. Tap Start, tap Settings, tap the System tab, and tap Power to see the indicator.

Use the Pocket PC cradle and AC adapter to charge the battery. You can also directly charge the
Pocket PC using the AC adapter.

Note   Before using your Pocket PC for the first time, you need to charge the battery for
approximately 30 minutes to an hour. Do not use the Pocket PC until the battery is fully charged,
as indicated by the steady amber battery-charging LED going off.

Charge the battery as follows:

1. If you are using the cradle for charging, plug the Pocket PC into the cradle.

2. You may need to connect the appropriate converter to the AC adapter’s plug according to
your country.

3. If you are using the cradle for charging, plug the AC adapter into the power connector on
the back of the cradle.

If you are not using the cradle, plug the AC adapter directly into the power connector on the
right side of the Pocket PC.

Charging the Battery
A – Battery Charging LED D – Cradle
B – Pocket PC E – Power Connector
C – AC Adapter
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4. Plug the other end of the AC adapter into an AC outlet.

 The battery-charging LED lights amber, indicating that the battery is charging.

 You can also check the “power remaining” indicator.

5. When the battery is charged, the following occurs.

 The battery-charging LED is off.

 The “power remaining” indicator indicates 100%.

Now calibrate and activate your Pocket PC (see “Calibrate and Activate the Pocket PC” in the
following section). Calibration must be done to ensure proper operation of your Pocket PC.

You can leave the Pocket PC in the cradle and the AC adapter connected to keep your battery
charged.

Note   Whenever possible, keep your Pocket PC connected to the AC adapter and a power
source. Doing so keeps the battery charged.

Calibrate and Activate the Pocket PC
It is essential that you calibrate and activate your Pocket PC before you use it. This ensures
accurate positioning when entering text and selecting menus. Calibrate and activate the Pocket
PC as follows.

1. Press the power button to power on the Pocket PC.

2. Tap the touch screen with the stylus to start the calibration and activation.

3. At the prompt to align the screen, tap the centre of the cross wherever the travelling cross
stops on the screen. You might have to do this several times to properly calibrate.

4. On completion of the screen calibration, follow the screen prompts to complete the
activation.

 At the “Stylus” screen, tap Next to continue.

 At the “pop-up menus” screens, perform the indicated operations.

 At the “Congratulations” screen, tap Next to continue.

 At the “location” screen, select your time zone and tap Next to continue.

 At the “completion” screen, tap the screen to continue.

 The “Today” screen displays.

Your Pocket PC is now ready to use. The following sections describe the Pocket PC’s two basic
screens and how to use them for performing functions. Also included is information for
installing ActiveSync on your desktop computer.

Learn the Basics
There are two basic screens you need to know about to get started. These are the “Today” screen
and the “Navigation Bar” screen.

The first screen that you normally see on startup is the “Today” screen. This screen displays
your important events (for example, current date and time, your name, upcoming appointments,
unread messages, tasks).
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Tapping  or tapping Start on the “Today” screen with the stylus takes you to the “Navigation
Bar” screen. At the Navigation Bar, you can select and access the programs available on your
Pocket PC. Tap Start to go back to the “Today” screen.

Your actions on these basic screens are controlled with the stylus. The stylus is used as follows.

 Tap — touch the screen once with the stylus to open programs and select options.

 Drag — hold the stylus on the screen and drag across the screen to select text and images.
Drag in a list to select multiple items.

 Tap and Hold — tap and hold the stylus on an item to see a list of actions available for that
item. On the displayed pop-up menu, tap the action that you want to perform.

For more information on using the “Today” screen, Navigation Bar, and stylus, see the
following sections.

Today Screen
The “Today” screen normally appears whenever you power up the Pocket PC. On the “Today”
screen, you can see at a glance your important information for the day. The following figure
shows a typical “Today” screen and what you can do from it.

Typical Today Screen

At the top of the screen is the “Start” bar. The bar displays the current time and any active
program. The bar also allows you to switch to programs and close screens.

From the “Today” screen, you can select any of the listed activities by tapping on your selection
with the stylus. For example, if you just activated your Pocket PC, you might want to enter your
name as the owner. Do this as follows.

1. At the “Today” screen, tap Tap here to set owner information.

2. At the “Owner Information” screen, tap the triangle at the lower right of the screen.

3. At the “Options” screen, tap Keyboard. A soft keyboard displays.



1-14  Get Started

4. Tap once in the “Name” field. A blinking cursor appears, indicating that you can enter data.

5. Use the keyboard to tap in your name, just as you would with your computer keyboard.

6. If you make a mistake and need to remove a letter(s) or remove a word(s), you can

 correct minor mistakes by placing the cursor after the letter or letters to be deleted and
pressing the backspace arrow on the keyboard to delete the letter or letters.

 highlight a whole word(s) with the stylus and pressing and holding the stylus on the
word(s). A pop-up menu gives options to Undo, Cut, Copy, Paste, Clear, or Select All.

7. When done, click on OK. Your changes are saved and the “Today” screen displays with
your name as the owner.

At the bottom of the “Today” screen is the Command Bar. Tapping New on the bar lists several
tasks that you can tap to open. Use this as a short cut to open any of the listed tasks.

By using the stylus and several control buttons, you can open tasks from the “Today” screen and
Navigation Bar and enter or read data at selected screens.

Navigation Bar Screen
To switch to the “Navigation Bar” screen, tap  or tap Start at the top of the “Today” screen.
The Navigation Bar displays on the “Today” screen.

From the Navigation Bar, you can select any one of the listed activities by tapping on your
selection with the stylus. You can also use the navigation buttons on the front of the Pocket PC
or the scroll dial on the side of the Pocket PC to scroll up or down, then open the highlighted
program by pressing the dial.

Typical Navigation Bar Screen

The “Start” bar at the top of the screen displays the time and one or more status icons. The bar
also displays the  icon which you can tap to return to the “Today” screen. A Command Bar
appears at the bottom of the screen. Tap New in the bar to return to the “Today” screen.

To select a program from the Navigation Bar (for example, Contacts), tap  or tap Contacts.
You can also tap the Contacts button on the front of the Pocket PC. Note the Contacts
command bar at the bottom of the screen.

The Contacts command bar has a New button for creating a new contact, a View button for
selecting the type of contact, a Tools button for performing various tasks, and an input panel
button. Tapping the input panel button displays a soft keyboard which you can use to create or
edit a contact.
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You can also input information by writing data on the screen. Tap the triangle in the lower right
corner of the screen, and tap Block Recognizer, Letter Recognizer, or Transcriber. For
information on using each input device, tap ? (Help) to open a help screen.

By tapping X in the upper right corner of the screen, you can start using any other program.  The
information you have entered will be stored automatically.

Many of the programs available on your Pocket PC are selected and used in a manner similar to
that described for Contacts.

The following table lists the activities on your Navigation Bar. To see the list on your Pocket
PC, tap Start to open the “Navigation Bar” screen. Tap Programs to see more activities. Look
on the Companion CD for additional programs that you might want to install.

Activities
Icon Program Description

ActiveSync Synchronise information between your Pocket PC and computer.

Calendar Keep track of your appointments and create meeting requests.

Contacts Keep track of your colleagues and friends.

Inbox Send and receive e-mail messages.

Internet
Explorer

View Web pages downloaded from your computer or connect to
the Internet to browse the Web.

Notes Create hand-written or typed notes, drawings, and recordings.

Tasks Keep track of your tasks.

Windows Media Play audio or video files.

Programs Tap Programs to see a list of the various programs available to
you.

Settings Tap Settings to see the various areas that you can access for
changing/reviewing settings.

Find Tap Find to find data in your Pocket PC.

Help Tap Help to see the Help Contents.

For further information on accessing and using the activities, tap Help on the Navigation Bar.

Install ActiveSync
A key component of your Pocket PC is the Microsoft ActiveSync program. With Microsoft
ActiveSync, you can synchronise the information on your computer with the information on
your Pocket PC and update both with the most recent information.

For example:

 Keep Microsoft Pocket Outlook® data up-to-date by synchronising your Pocket PC with
Microsoft Outlook data on your computer.

 Synchronise Microsoft Word and Microsoft Excel files between your Pocket PC and
computer (to do so you should have Microsoft Word and Excel installed on your computer).
Your files are automatically converted to the correct format.

Note   By default, ActiveSync does not automatically synchronise all types of information. Use
ActiveSync options to turn synchronisation on and off for specific information types.
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With ActiveSync, you can also:

 Back up and restore your Pocket PC data.

 Copy (rather than synchronise) files between your Pocket PC and computer.

 Control when synchronisation occurs by selecting a synchronisation mode. For example,
you can synchronise continually while connected to your computer or only when you
choose the synchronise command.

 Select which information types are synchronised and control how much data is
synchronised. For example, you can choose how many weeks of past appointments you
want synchronised.

Your Pocket PC comes with ActiveSync already installed. However, to synchronise information
with your computer, you must also install ActiveSync on your computer.

Install ActiveSync on your computer from the Companion CD as follows.

Note   Before starting the ActiveSync installation, ensure that you have Microsoft® Outlook®
installed on your computer. Microsoft Outlook is included with Microsoft Office. If you have
Outlook 98 or Outlook 2000 installed, you are encouraged to update to Outlook 2002. You should
install Outlook before starting the ActiveSync installation.

Note   Do not connect your Pocket PC and cradle to the computer until ActiveSync is installed.

1. Power on your computer and monitor.

2. Insert the Companion CD into the CD-ROM drive of your computer. The CD autoruns and
displays the “Getting Started with Your Pocket PC” screen.

3. At the “Getting Started with Your Pocket PC” screen, click on Start Here.

4. At the “Start Here” screen,

 Please read the Overview before installing ActiveSync.

 Click on Download Connection Wizard and read the overview to see if you require the
wizard. Follow the prompts to install the wizard on your computer. Return to the “Start
Here” menu when done.

5. At the “Start Here” screen, click on Install ActiveSync 3.5a.

6. At the “Install ActiveSync 3.5a” screen, click on Install.

7. At the “File Download” screen, click on Run this program from its current location.

8. Follow the prompts to install ActiveSync on your computer. When prompted, connect your
Pocket PC to your computer.

 Install the Pocket PC in the cradle.

 Connect the AC adapter to the cradle and power.

 Connect the USB PC synchronisation cable to your computer.
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Synchronising Setup

A – Pocket PC D – USB PC Cable
B – Cradle E – Computer
C – AC Adapter

9. At the “Add New Hardware Wizard” screen, click on Next and follow the prompts.

 Click on OK to continue.

10. Follow the prompts to complete the synchronisation and establish a partnership between
your Pocket PC and your computer.

Your first synchronisation begins when the installation is completed. This takes time, as the
process is copying information to the Pocket PC.

On completion of synchronisation, you can either remove the Pocket PC from the cradle or leave
it in with AC power connected.

Press the power button on the Pocket PC and check your Calendar (tap the Calendar program
button or tap   and tap  (calendar)). Note that your calendar information in Microsoft
Outlook on your computer was copied to your Pocket PC. Also look at Contacts and Tasks. If
you have Contacts and Tasks information on your computer, you should see that information
copied to your Pocket PC.

When done, tap the X button at the top right of the screen to exit the program.

For further information on using Pocket PC ActiveSync, tap  at the “Today” screen and tap
Help at the “Navigation Bar” screen. At the “Help” screen, tap Connections and tap Set Up
Remote Synchronisation or tap Start and Stop Synchronisation.

For information about using ActiveSync on your desktop computer, start ActiveSync on your
desktop computer and click on ActiveSync Help.

Once you have installed ActiveSync on your computer and performed your first synchronisation,
synchronisation occurs whenever the ActiveSync components on the Pocket PC and on your
computer are activated.
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Use the cradle for automatic synchronisation. You can also use infrared for synchronisation. Set
the synchronisation type by tapping Tools on the “ActiveSync” screen, tapping Connect via IR,
or tapping Options then USB Sync.

Using a Secure Digital Card or MMC Card
A Secure Digital (SD) card or MMC card can be used to contain productivity and entertainment
programs that you can install on your Pocket PC.

To install an SD card and any of its programs, use the following procedure.

1. Press the Pocket PC power button.

2. Insert the SD card into the SD slot on the top of your Pocket PC. A menu displays on the
Pocket PC, showing you the contents of the card.

3. Select a program and follow the prompts to load it on your Pocket PC.

4. When finished, remove the SD card and store it in an anti-static bag.

Access Pocket PC Functions
The following table is a guide to many of the functions and settings for the Pocket PC. Included
in the table is the tapping path for accessing the function from the Navigation Bar. Note that not
all functions are listed and some settings and selections may differ from that on your Pocket PC.

Accessing Pocket PC Functions
Function Access

About Pocket PC Tap Start, tap Settings, tap System tab, and tap About to see
Pocket PC version and processor type.

ActiveSync Tap Start, tap ActiveSync, and tap Sync or Tools.

Align Screen Tap Start, tap Settings, tap System tab, and tap Screen.

Backlight Settings Tap Start, tap Settings, tap System tab, and tap Backlight.

Battery Status Tap Start, tap Settings, tap System tab, and tap Power.

Buttons, Front Tap Start, tap Settings, and tap Buttons.

Calendar Press Calendar program button on the front or tap Start and tap
Calendar.

Clock Tap Start, tap Settings, tap System tab, and tap Clock.

Contacts Press Contacts program button on the front or tap Start and tap
Contacts.

File Explorer Tap Start, tap Programs, and tap File Explorer.

Find Tap Start and tap Find.

Help Tap Start, tap Help, and select a help item.

Inbox Tap Start and tap Inbox.

Infrared Receive Tap Start, tap Programs, and tap Infrared Receive.

Input Panel Tap Start, tap Settings, and tap Input. Select input method.

Internet Explorer Tap Start and tap Internet Explorer (requires optional modem or
Pocket PC synched to computer).
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Accessing Pocket PC Functions
Function Access
Memory Settings Tap Start, tap Settings, tap System tab, and tap Memory.

MSN Messenger Tap Start, tap Programs, and tap MSN Messenger.

Notes Tap Start and tap Notes.

Owner information At the Start screen, tap Owner, and enter information.

Password Tap Start, tap Settings, and tap Password.

Pocket Excel Tap Start, tap Programs, and tap Pocket Excel.

Pocket PC Basics Tap Start, tap Help, and tap Pocket PC Basics.

Pocket Word Tap Start, tap Programs, and tap Pocket Word.

Programs Tap Start and tap Programs. Select Games, Calculator, File
Explorer, Infrared Receive, Microsoft Reader, MSN Messenger,
Pocket Excel, Pocket Word, or Terminal Services.

Regional Settings Tap Start, tap Settings, tap System tab, and tap Regional Settings.

Settings, Connections Tap Start, tap Settings, and tap Connections tab. Select AvantGo
Connect, Beam, Connections, or Network Adapters.

Settings, Personal Tap Start, tap Settings, and tap Personal tab. Select Buttons, Input,
Menus, Owner Information, Password, Sounds & Notifications, or
Today.

Settings, System Tap Start, tap Settings, and tap System tab. Select About,
Backlight, Clock, Contrast, Memory, Power, Regional Settings,
Remove Programs, or Screen.

Sound Volume Tap Start, tap Settings, and tap Sounds & Notifications.

Start Menu Tap Start, tap Settings, tap Menus, and select programs to appear
on Start menu.

Tasks Tap Tasks button on the front or tap Start and tap Tasks.

Windows Media Tap Start and tap Windows Media.

Get Help
The following table provides a comprehensive list of where you can get help and information on
your Pocket PC, the software, connections, accessories, and support.

Help Resources
Item Resource

Pocket PC Operation Pocket PC Getting Started Guide
Pocket PC Reference Guide (on Companion CD)

Windows Pocket PC Windows Pocket PC Help
Help file included with Windows Pocket PC. Tap Start on the
Today screen, tap Help on the Navigation Bar screen, and tap an
item on the Help Contents screen.

Windows Pocket PC web site
www.microsoft.com/mobile/pocketpc/
howdoi/default.asp
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Help Resources
Item Resource
ActiveSync ActiveSync Help on your computer

After installing ActiveSync on your computer, click on
Start/Programs/ActiveSync to open the ActiveSync window.
Select Help from the menu bar and click on Microsoft ActiveSync
Help.

ActiveSync Help on your Pocket PC
Tap  at the Today screen and tap Help. At the Help Contents
screen, tap Connections. Select a topic for help.

ActiveSync Help on the Web
www.microsoft.com/mobile/pocketpc/
howdoi/default.asp

Pocket Word, Excel,
Reader, Outlook (Inbox,
Calendar, Contacts,
Tasks, Notes), Windows
Media Player, Internet
Explorer

Microsoft Pocket PC Features
www.microsoft.com/mobile/pocketpc/
bguide/features/mobile_software.asp

Software and Hardware
Resources

Pocket PC Magazine
www.ppcmag.com
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Pocket PC Care
Your Pocket PC is a durable, dependable unit built for extensive use and travel. Follow these
guidelines to maintain the condition and performance of the Pocket PC.

 Clean your Pocket PC with a soft, clean, slightly damp, almost dry cloth. Use only water to
dampen the cloth. Do not use any type of cleaning products or soap or you might damage
the touch screen and discolour the case finish.

 Do not spray liquids on the touch screen and case or allow liquids to drip into the Pocket
PC.

 Do not put anything on top of the touch screen.

 Always use the stylus to prevent scratching the touch screen.

 Do not expose your Pocket PC to moisture and temperature extremes.

 Avoid dropping or bumping the Pocket PC or the AC adapter.

 Do not use the Pocket PC in humid or dusty environments.

 Avoid leaving the Pocket PC and its components in direct sunlight or near heat sources.
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Learn the Basics

 Overview
 Pop-up Menus
 Notifications
 Enter Information
 Enter Text with the Input Panel
 Write on the Screen
 Draw on the Screen
 Record a Message
 Use a Preset or Frequently Used Message
 Find and Organise Information
 Customise Your Pocket PC
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Overview
This chapter describes the basics for using your Pocket PC. Included are the following topics:

 pop-up menus

 notifications

 enter information

 enter text

 write and draw on the screen

 record a message

 use a preset message

 find information

 customise your Pocket PC.

Pop-up Menus
Pop-up menus are used throughout your Pocket PC and vary slightly from program to program.
With pop-up menus, you can quickly choose an action for an item.

For example, you can use the pop-up menu in the Tasks list to quickly delete a task or create a
copy. To access the pop-up menu, tap and hold the stylus on the task name that you want to copy
or delete. When the pop-up menu appears, lift the stylus and tap the action you want to perform.
To close the menu without performing an action, tap outside the menu.

Pop-up Menu

Notifications
Your Pocket PC can remind you of things to do. For example, if you have set up an appointment
in Calendar, a task with a due date in Tasks, or an alarm in Clock, you are notified in any of the
following ways.

 A message box appears on the screen.

 A sound is played (you can specify the type of sound).
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 A light flashes on the Pocket PC.

To select reminder types and sounds, tap  and tap Settings. In Settings, tap Sounds &
Notifications. Make your choices and tap OK when done. Keep in mind that what you choose
applies throughout your Pocket PC.

Enter Information
Information is entered into your Pocket PC in several ways:

 Enter typed text in the input panel by using the soft keyboard or Letter Recognizer.

 Write or draw pictures directly on the screen with the stylus.

 Speak into your Pocket PC microphone to record a message.

 Use ActiveSync to synchronise or copy information from your computer to the Pocket PC.

Enter Text with the Input Panel
Use the input panel in the Command Bar to select the way you want to enter information in any
program on your Pocket PC. You can either type using the soft keyboard or write using Letter
Recognizer, Block Recognizer, or Transcriber. Whatever you choose, the characters appear as
typed text on the screen.

To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the Input
Panel button to see your options.

Selecting the Input Panel

Using the Soft Keyboard
Use the soft keyboard to enter words as follows. To demonstrate, open Notes.

1. In Notes, tap the arrow next to the input panel and tap Keyboard at the Options pop-up.

2. Use your stylus to tap the keys to enter your information.

When you use the input panel and the soft keyboard, your Pocket PC anticipates the word you
are typing or writing and displays it on the screen. When you tap the displayed word, it is
inserted into the text at the insertion point. The more you use Pocket PC, the more words it
learns to recognise.
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Using the Soft Keyboard

Note   To change word suggestion options, such as the number of words suggested at a time,
tap , tap Settings, tap the Personal tab, tap Input, and tap the Word Completion tab.

Using Letter Recognizer
With Letter Recognizer, you can use the stylus to write letters, just as you would on paper. Use
these steps to write with Letter Recognizer.

1. Tap the arrow next to the input panel button and tap Letter Recognizer.

2. Write a letter in the box.

The written letter is converted to typed text and is displayed on the screen. For further
information on using Letter Recognizer, tap the question mark next to the writing area.

Using Block Recognizer
With Block Recognizer, you can the stylus to input character strokes that are similar to those
used on other devices. Use these steps to write with Block Recognizer.

1. Tap the arrow next to the input panel button and tap Block Recognizer.

2. Writer a letter in the box.

The written letter is converted to typed text and is displayed on the screen. For further
information on using Block Recognizer, tap the question mark next to the writing area.
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Using Transcriber
With Transcriber, you can use the stylus to write anywhere on the screen, just as you would on
paper. Unlike Letter Recognizer and Block Recognizer, you can write a sentence or additional
information. Pause after writing and let Transcriber change the written characters to typed
characters. Use these steps to write with Transcriber.

1. Tap the arrow next to the input panel button and tap Transcriber.

2. Write anywhere on the screen.

The written words are converted to typed text and displayed on the screen. For further
information on using Transcriber, tap the question mark in the lower right corner of the screen.

Editing Your Text
If you want to edit or format typed text, you must first select the text.

1. Highlight the text by dragging the stylus across the text.

2. Tap and hold the selected words and tap an editing command on the pop-up menu (cut,
copy, paste) or tap the command on the Edit menu.

Write on the Screen
In any program that accepts writing, such as the Notes program, and in the Notes tab in
Calendar, Contacts, and Tasks, you can use your stylus to write directly on the screen. Write the
way you do on paper. You can edit and format what you have written and convert the
information to text at a later time.

Writing on the Screen
You can write directly on the screen in Notes as follows.

1. Open Notes in your Pocket PC.

2. Tap the Pen button to switch to the writing mode. The screen displays blank space with
lines to help you write.

3. Write your message on the screen (see the following figure).
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Writing in Notes

Note   Some programs that accept writing might not have the Pen button. See the
documentation that may come with some programs to find out how to switch to the writing mode.

Editing Your Writing
If you want to edit or format your writing, you must first select the writing, then edit it. Do this
as follows.

1. Tap and hold the stylus next to the writing you want to select, until the insertion point
appears.

2. Without lifting the stylus, drag it across the writing you want to select.

3. Tap and hold the writing, then tap an editing command on the pop-up menu (cut, copy,
paste) or tap the command on the Edit menu.

If you accidentally write on the screen, tap Tools, tap Undo, and try again. You can also select
your writing by tapping the Pen button to deselect it and then dragging the stylus across the
screen.
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Converting Your Writing to Text
After you hand wrote your message, you can convert it to text. Do it as follows:

1. If you only want to convert certain words, select them before going to the next step.

Selecting and Converting Your Writing

2. Tap Tools and tap Recognise. Your writing is converted to text.

You can also tap and hold the selected words until the pop-up screen displays, then tap
Recognise.

If a word is not recognised, it is left as writing.

If the conversion is not correct, you can select different words from a list of alternates or return
to the original writing.

1. Tap and hold the incorrect word (one word at a time).

2. At the pop-up menu, tap Alternates. A menu with a list of alternate words displays.

Selecting Alternate Words
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3. Tap the word you want to use or tap the writing at the top of the menu to return to the
original writing.

Here are some tips for getting good resolution.

 Write neatly.

 Write on the lines and draw descenders below the line. Write the cross of the “t” and
apostrophes below the top line so that they are not confused with the word above. Write
periods and commas above the line.

 For better recognition, try increasing the zoom level to 300% using the Tools menu.

 Write the letters of a word closely and leave big gaps between words so that the Pocket PC
can easily tell where words begin and end.

 Hyphenated words, foreign words that use special characters such as accents, and some
punctuation cannot be converted.

 If you add writing to a word to change it (such as changing a “3” to an “8”) after you
attempt to recognise the word, the writing you add will not be included if you attempt to
recognise the writing again.

Draw on the Screen
You can draw on the screen in the same way that you write on the screen. The difference
between writing and drawing on the screen is how you select items and how they are edited. For
example, selected drawings can be resized while writing cannot.

Creating a Drawing
You create a drawing by first creating a box on the screen, then make your drawing within the
box. Do this as follows, using Notes as an example.

1. Use your stylus to make a stroke three ruled lines high. A dotted drawing box appears.

2. Make your drawing in or touching the drawing box and crossing three ruled lines. If the
drawing does not cross three lines, it changes to writing.

Creating a Drawing
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Note   You might want to change the zoom level to more easily work on or view your drawing.
Tap Tools and tap a zoom level.

Editing Your Drawing
If you want to edit or format your drawing, you must first select the drawing, then edit it. Do this
as follows:

1. Tap and hold the stylus on the drawing until the selection handle appears.

To select multiple drawings, deselect the Pen button and then drag to select the drawings
you want.

2. Tap and hold the selected drawing, then tap an editing command on the pop-up menu (cut,
copy, paste) or tap the command on the Edit menu.

3. Resize a drawing by deselecting the Pen button (if selected) and dragging a selection handle
to the size you want.

Record a Message
In any program where you can write or draw on the screen, you can also quickly capture
thoughts, reminders, and phone numbers by recording a message. In Calendar, Tasks, and
Contacts, you can include a recording in the Notes tab.

In the Notes program, you can either create a stand-alone recording or include a recording in a
written note. If you want to include the recording in a note, open the note first.

In the Inbox program, you can add a recording to an e-mail message.

Create a recorded message in the Notes program as follows. Recording in other programs is
similar.

1. Hold the Pocket PC microphone near your mouth or other source of sound.

2. Press and hold the Record button on your Pocket PC until you hear a beep.

3. While holding down the Record button, make your recording.

4. To stop recording, release the Record button. Two beeps sound. The new recording appears
in the note list or as an embedded icon (see the following figure).

Note   You can also make a recording by tapping the Record button on the Recording toolbar.

To play a recording, tap it in the list or tap its icon in the note.
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Recording a Message

Use a Preset or Frequently Used Message
When using Inbox or MSN Messenger, use My Text to quickly insert preset or frequently used
messages into the text entry area. To insert a message, tap My Text and tap a message.

Note   You can add text after inserting a My Text message. However, you have to add it
before sending the message.

Using a Preset Message

To edit a My Text message, tap Edit in the Tools menu, and tap My Text Messages. Select the
message you want to edit and make the desired changes.
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Find and Organise Information
The Find feature on your Pocket PC helps you to quickly locate information. You can also
organise your information with File Explorer.

Use the following steps to find information.

1. On the  menu, tap Find.

2. Enter the text you want to find, select a data type, and tap Go to start the search.

Note   To quickly find information that is taking up storage space on your Pocket PC, tap
Larger than 64 KB in Type.

Use these steps to find files and to organise your information with File Explorer.

1. On the  menu, tap Programs and tap File Explorer.

2. Move files by tapping and holding the item you want to move and tapping Cut or Copy and
Paste on the pop-up menu.

Organise Files
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Customise Your Pocket PC
You can customise your Pocket PC by adjusting its settings and installing additional software.

Adjusting Settings

You can adjust Pocket PC settings to suit the way you work. To see available options, tap ,
tap Settings, and tap the Personal or System tab located at the bottom of the screen.

You also might want to adjust the following.

 Clock — change the time or set alarms

 Menus — customise what appears on the  menu, and enable a pop-up menu from the
New button

 Owner Information — enter your contact information

 Password — limit access to your Pocket PC

 Power — maximise battery life

 Today — customise the look and the information that is displayed on the “Today” screen.

Adding or Removing Programs
Programs added to your Pocket PC at the factory are stored in read-only memory (ROM ). You
cannot remove this software, and you will never accidentally lose ROM contents. The ROM
programs can be updated using special installation programs with a *.xip extension. All other
programs and data files added to your Pocket PC after factory installation are stored in random
access memory (RAM).

You can install any program created for your Pocket PC, as long as it has enough memory. The
most popular place to find software for your Pocket PC is on the Pocket PC Web site
(http://www.microsoft.com/mobile/pocketpc).

Using ActiveSync to Add Programs
You will need to install the appropriate software for your Pocket PC on your computer.
ActiveSync is already installed on your Pocket PC.

1. Determine your Pocket PC and processor type so that you know which version of the
software to install. Tap  and tap Settings. On the System tab, tap About. In the Version
tab, make a note of the information in Processor.

2. Insert the CD that contains the program into your desktop computer. You might see a single
*.xip,  *.exe, or *.zip file, a Setup.exe file, or several versions of files for different device
types and processors. Be sure to select the program designed for the Pocket PC and your
Pocket PC processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the
program. Many programs provide special installation instructions.

4. Connect your Pocket PC and computer.

5. Double-click on the *.exe file.

 If the file is an installer, the installation wizard begins. Follow the directions on the
screen. Once the software has been installed on your computer, the installer
automatically transfers the software to your Pocket PC.
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 If the file is not an installer, you will see an error message stating that the program is
valid but it is designed for a different type of computer. You will need to move this file
to your Pocket PC. If you cannot find any installation instructions for the program in
the Read Me file or documentation, use ActiveSync Explore to copy the program file to
the Program Files folder on your Pocket PC. For more information on copying files
using ActiveSync, see ActiveSync Help.

6. Once installation is complete, tap , tap Programs, and tap the program icon to switch to
it.

Using the Internet to Add Programs
Use the following procedure to load programs from the Internet on your Pocket PC.

Note   To use the Internet, you need to be connected through an optional modem card or
network card installed on your Pocket PC.

1. Determine your Pocket PC and processor type so that you know which version of the
software to install. Tap  and tap Settings. On the System tab, tap About. In the Version
tab, make a note of the information in Processor.

2. Download the program to your Pocket PC straight from the Internet using Pocket Internet
Explorer. You might see a single *.xip,  *.exe or *.zip file, a Setup.exe file, or several
versions of files for different device types and processors. Be sure to select the program
designed for the Pocket PC and your Pocket PC processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the
program. Many programs provide special installation instructions.

4. Tap the file, such as a *.xip or *.exe file. The installation wizard begins. Follow the
directions on the screen.

Adding a Program to the Start Menu
Use the following procedure to add a program to the Start menu.

1. Tap , tap Settings, tap Menus, tap the Start Menu tab, and tap the check box for the
program. If you do not see the program listed, you can either use File Explorer on the
Pocket PC to move the program to the Start Menu folder or use ActiveSync on the desktop
computer to create a shortcut to the program and place the shortcut in the Start Menu folder.

2. If you are using File Explorer on the Pocket PC:

 Tap , tap Programs, tap File Explorer, and locate the program (tap the folder list,
labelled My Documents by default, and tap My Device to see a list of all folders on the
Pocket PC).

 Tap and hold the program and tap Cut on the pop-up menu. Open the Start Menu folder
located in the Windows folder, tap and hold a blank area of the window, and tap Paste
on the pop-up menu.

 The program appears on the  menu. For more information on using File Explorer,
see “Find and Organise Information,” earlier in this chapter.

3. If you are using ActiveSync on the desktop computer:

 Use the Explorer in ActiveSync to explore your Pocket PC files and locate the program.
Right-click on the program, and then click on Create Shortcut.
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 Move the shortcut to the Start Menu folder in the Windows folder. The shortcut appears
on the  menu. For more information, see ActiveSync Help.

Removing a Program from the Start Menu
Use the following procedure to remove a program from the Start menu.

1. Tap  and tap Settings. On the System tab, tap Remove Programs.

2. If the program does not appear in the list of installed programs, use File Explorer on your
Pocket PC to locate the program, tap and hold the program, and then tap Delete on the pop-
up menu.



3
Use Microsoft Pocket Outlook

 Calendar
 Contacts
 Tasks
 Notes
 Inbox
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Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use
these programs individually or together. For example, e-mail addresses stored in Contacts can be
used to address e-mail messages in Inbox.

Using ActiveSync, you can synchronise information in Microsoft Outlook or Microsoft
Exchange on your desktop computer with your Pocket PC. You can also synchronise this
information directly with a Microsoft Exchange server. Each time you synchronise, ActiveSync
compares the changes you made on your Pocket PC and computer and updates both computers
with the latest information. For information on using ActiveSync, see ActiveSync Help on the
computer.

You can switch to any of these programs by tapping them on the  menu.

Calendar: Scheduling Appointments and Meetings
Use Calendar to schedule appointments, including meetings and other events. You can check
your appointments in one of several views (Agenda, Day, Week, Month, and Year) and easily
switch views by using the View menu.

Calendar Screen

Note   You can customise the Calendar display, such as changing the first day of the week, by
tapping Options on the Tools menu.

Creating an Appointment
Create an appointment for the calendar as follows:

1. If you are in the Day or Week view, tap the desired date and time for the appointment.

2. Tap New. Tap the up arrow and select an input device (keyboard, letter recognizer).

3. Select a field (Subject, etc.). Using the keyboard or letter recognizer, enter a description and
a location.

4. If needed, tap the date and time to change them.

5. Enter other desired information. You need to hide the keyboard to see all available fields.
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Calendar Appointment

6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more
information on creating notes, see “Notes: Capturing Thoughts and Ideas,” later in this
chapter.

7. When finished, tap OK to return to the calendar.

Note   If you select Remind me in an appointment, your Pocket PC reminds you according to
the options set in , Settings, Personal tab, Sounds & Notifications.

Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. To change the
appointment, tap Edit.

Summary Screen
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Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting
request is created automatically and sent either when you synchronise Inbox or when you
connect to your e-mail server. Indicate how you want meeting requests sent by tapping Tools
and tapping Options. If you send and receive e-mail messages through ActiveSync, select
ActiveSync.

Schedule a meeting
You can schedule a meeting as follows:

1. Create an appointment.

2. In the appointment details, hide the input panel, and tap Attendees.

3. From the list of e-mail addresses you have entered in Contacts, select the meeting attendees.

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help and Inbox
Help on the Pocket PC.

Contacts: Tracking Friends and Colleagues
Contacts maintains a list of your friends and colleagues so that you can easily find the
information you are looking for, whether you are at home or on the road. Using your infrared
(IR) port, you can quickly share Contacts information with other device users with IR
capabilities.

Contacts Screen

Note   To change the way information is displayed in the list, tap Tools and tap Options.
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Creating a Contact
Create a contact as follows:

1. Tap New.

2. Using the input panel keyboard (or other input device), enter a name and other contact
information. Scroll down to see all the available fields.

Contacts Input Panel

3. To assign the contact to a category, scroll to and tap Categories and select a category from
the list. In the contact list, you can display contacts by category.

4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more
information on creating notes, see “Notes: Capturing Thoughts and Ideas,” later in this
chapter.

5. When finished, tap OK to return to the contact list.

Finding a contact
There are four ways to find a contact:

 In the contact list, enter a contact name in the box under the navigation bar. To show all
contacts again, clear text from the box or tap the button to the right of the box.

 In the contact list, tap the category list (labelled All Contacts by default) and select the type
of contact that you want displayed. To show all contacts again, select All Contacts. To view
a contact not assigned to a category, select None.

 To view the names of companies your contacts work for, in the contact list, tap View > By
Company. The number of contacts that work for that company are displayed to the right of
the company name.

 Tap , tap Find, enter the contact name, select Contacts for the type, and tap Go.
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Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed. To change the contact
information, tap Edit.

Contacts Summary Screen

Tasks: Keeping a To Do List
Use Tasks to keep track of what you have to do.

Tasks Screen

Note   To change the way information is displayed in the list, tap Tools and tap Options.
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Creating a task
Create a task as follows:

1. Tap New.

2. Using the input panel keyboard, enter a description.

Tasks Input Panel

3. You can enter a start date and due date or enter other information by first tapping the field.
If the input panel is open, you need to hide it to see all available fields.

4. To assign the task to a category, tap Categories and select a category from the list. In the
task list, you can display tasks by category.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more
information on creating notes, see “Notes: Capturing Thoughts and Ideas,” later in this
chapter.

6. When finished, tap OK to return to the task list.

Note   To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Tap on
Tap here to add a new task and enter your task information.
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Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed. To change the task, tap Edit.

Tasks Summary Screen

Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can
create a written note or a recording. You can also include a recording in a note. If a note is open
when you create the recording, it is included in the note as an icon. If the note list is displayed, it
is created as a stand-alone recording.

Notes Screen
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Creating a Note
Create a note as follows:

1. Tap New.

2. Create your note by writing, drawing, typing, and recording. For more information about
using the input panel, writing and drawing on the screen, and creating recordings, see
Chapter 2.

Notes Input Screen

Inbox: Sending and Receiving E-mail
Use the Inbox to send and receive e-mail messages in one of several ways:

 Synchronise e-mail messages with Microsoft Exchange or Microsoft Outlook on your
desktop computer.

 Send and receive e-mail messages by connecting directly to an e-mail server through an
Internet Service Provider (ISP) or a network. You will need an optional modem or network
card installed on your Pocket PC to connect to your ISP or network.
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Synchronising E-mail Messages
E-mail messages can be synchronised as part of the general synchronisation process. To do this,
you need to enable Inbox synchronisation in ActiveSync. For information on enabling Inbox
synchronisation, see ActiveSync Help on the desktop computer.

During synchronisation:

 Messages are copied from the mail folders of Exchange or Outlook on your desktop
computer to the ActiveSync folder in Inbox on your Pocket PC. By default, you receive
messages from the past three days only, the first 100 lines of each message, and file
attachments of less than 100 KB in size.

 E-mail messages in the Outbox folder on your Pocket PC are transferred to Exchange or
Outlook, and then sent from those programs.

 E-mail messages in subfolders must be selected in ActiveSync on your desktop computer in
order to be transferred.

Note   You can also synchronise e-mail messages with your desktop computer from a remote
location. For more information, see Chapter 6.

Connecting Directly to an E-mail Server
In addition to synchronising e-mail messages with your desktop computer, you can send and
receive e-mail messages by connecting to an e-mail server using an optional modem or network
card connected to your Pocket PC. You will need to set up a remote connection to a network or
an ISP, and a connection to your e-mail server. For more information, see Chapter 6.

When you connect to the e-mail server, new messages are downloaded to the Pocket PC Inbox
folder, messages in the Pocket PC Outbox folder are sent, and messages that have been deleted
on the e-mail server are removed from the Pocket PC Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather
than your desktop computer. When you delete a message on your Pocket PC, it is also deleted
from the e-mail server the next time you connect based on the settings you selected in
ActiveSync.

You can work online or offline. When working online, you read and respond to messages while
connected to the e-mail server. Messages are sent as soon as you tap Send, which saves space
on your Pocket PC.

When working offline, once you have downloaded new message headers or partial messages,
you can disconnect from the e-mail server and then decide which messages to download
completely. The next time you connect, Inbox downloads the complete messages you have
marked for retrieval and sends the messages you have composed.
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Using the Message List
Messages you receive are displayed in the message list. By default, the most recently received
messages are displayed first in the list.

Inbox Message List Screen

When you receive a message, tap it to open it. Unread messages are displayed in bold.

Message Screen
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When you connect to your e-mail server or synchronise with your desktop computer, by default,
you will receive messages from the last three days only, the first 100 lines of each new message,
and file attachments of less than 100 KB in size. The original messages remain on the e-mail
server or your desktop computer.

You can mark the messages that you want to retrieve in full during your next synchronisation or
e-mail server connection. In the message list, tap and hold the message you want to retrieve. On
the pop-up menu, tap Mark for Download. The icons in the Inbox message list give you visual
indications of message status.

You specify your downloading preferences when you set up the service or select your
synchronisation options. You can change them at any time.

 Change options for Inbox synchronisation using ActiveSync options. For more information,
see ActiveSync Help.

 Change options for direct e-mail server connections in Inbox on your Pocket PC. Tap Tools
and tap Options. On the Service tab, tap the service you want to change. Tap and hold the
service and tap Delete to remove a service.

Composing Messages
To compose a message, perform the following:

1. Tap New.

2. In the To field, enter an e-mail or SMS address of one or more recipients, separating them
with a semicolon, or select a name from the contact list by tapping the Address Book
button. All e-mail addresses entered in the e-mail fields in Contacts appear in the Address
Book.

Composing Screen
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3. Compose your message. To enter preset or frequently used messages, tap My Text and
select a message.

4. Tap Send when you have finished the message. If you are working offline, the message is
moved to the Outbox folder and is sent the next time you connect.

If you are sending an SMS message and want to know if it was received, before sending the
message, tap Edit, tap Options, and tap Request SMS text message delivery notification.

Managing E-mail Messages and Folders
By default, messages are displayed in one of five folders for each service you have created:
Inbox, Deleted Items, Drafts, Outbox, and Sent Items. The Deleted Items folder contains
messages that were deleted from the Pocket PC. The behaviour of the Deleted and Sent Items
folders depends on the options you have chosen. In the message list, tap Tools and tap Options.
On the Message tab, select your options.

If you want to organise messages into additional folders, tap Tools, and tap Manage Folders to
create new folders. To move a message to another folder, in the message list, tap and hold the
message and tap Move to on the pop-up menu.

Folder Behaviour with a Direct Connection to an E-mail Server
The behaviour of the folders you create depends on whether you are using ActiveSync, SMS,
POP3, or IMAP4.

 If you use ActiveSync, e-mail messages in the Inbox folder in Outlook are automatically
synchronised with your Pocket PC. You can select to synchronise additional folders by
designating them for ActiveSync. The folders you create and the messages you move are
mirrored on the server. For example, if you move two messages from the Inbox folder to a
folder named Family, and you have designated Family for synchronisation, the server
creates a copy of the Family folder and copies the messages into that folder. You can then
read the messages while away from your desktop computer.

 If you use SMS, messages are stored in the Inbox folder.

 If you use POP3 and you move e-mail messages to a folder you created, the link is broken
between the messages on the Pocket PC and their copies on the mail server. The next time
you connect, the mail server sees that the messages are missing from the device Inbox and
deletes them from the server. This prevents you from having duplicate copies of a message,
but it also means that you no longer have access to messages that you move to folders
created from anywhere except the Pocket PC.

 If you use IMAP4, the folders you create and the e-mail messages you move are mirrored
on the server. Therefore, messages are available to you anytime you connect to your mail
server, whether it is from your Pocket PC or desktop computer. This synchronisation of
folders occurs whenever you connect to your mail server, create new folders, or
rename/delete folders when connected.
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The companion programs consist of Microsoft Pocket Word, Microsoft Pocket Excel, Windows
Media™ Player for Pocket PC, and Microsoft Reader.

To switch to a companion program on your device, tap Programs on the  menu, and tap the
program name.

Note   All titles described in this chapter are optional and may not be included on your specific
Pocket PC. Your Pocket PC may also contain optional programs that are not documented in this
chapter.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give you easy access to
copies of your documents. You can create new documents on your Pocket PC, or you can copy
documents from your desktop computer to your Pocket PC. Synchronise documents between
your desktop computer and your Pocket PC so that you have the most up-to-date content in both
locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. To
create a new file, tap , tap Programs, tap Pocket Word, and tap New. A blank document
appears. Or, if you have selected a template for new documents in the Options dialogue box, that
template appears with appropriate text and formatting already provided. You can open only one
document at a time. When you open a second document, you will be asked to save the first. You
can save a document you create or edit in a variety of formats, including Word (.doc), Pocket
Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).

Pocket Word contains a list of the files stored on your Pocket PC. Tap a file in the list to open it.
To delete, make copies of, and send files, tap and hold a file in the list. Then, select the
appropriate action on the pop-up menu.

Pocket Word Folders Screen

You can enter information in Pocket Word in one of four modes (typing, writing, drawing, or
recording), which are displayed on the View menu. Each mode has its own toolbar, which you
can show and hide by tapping the Show/Hide Toolbar button on the command bar.
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Note   You can change the zoom magnification by tapping View and tapping Zoom. Select
the percentage you want. Select a higher percentage to enter text and a lower one to see more of
your document.

Note   If you are opening a Word document created on a desktop computer, select Wrap to
Window on the View menu so that you can see the entire document.

Typing Mode
Using the input panel (keyboard or other input mode), enter typed text into the document. For
more information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select text as you do in a
Word document, using your stylus instead of the mouse to drag through the text you want to
select. You can search a document to find text by tapping Edit and tapping Find/Replace.

Pocket Word Document
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a
guide, and the zoom magnification is greater than in typing mode to allow you to write more
easily. For more information on writing and selecting writing, see Chapter 2.

Pocket Word Writing Screen

Note   If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing,
and can be edited and manipulated as described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is converted
to a Word document on your desktop computer.
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Drawing Mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you
lift your stylus off the screen after the first stroke, you will see a drawing box indicating the
boundaries of the drawing. Every subsequent stroke within or touching the drawing box
becomes part of the drawing. For more information on drawing and selecting drawings, see
Chapter 2.

Pocket Word Drawing Screen

Recording Mode
In the recording mode, you can embed a recording into your document. Recordings are saved as
.wav files. For more information on recording, see Chapter 2.

For more information on using Pocket Word, tap  and tap Help.

Pocket Excel
Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to
copies of your workbooks. You can create new workbooks on your Pocket PC, or you can copy
workbooks from your desktop computer to your Pocket PC. Synchronise workbooks between
your desktop computer and your Pocket PC so that you have the most up-to-date content in both
locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs. To create a
new file, tap , tap Programs, tap Pocket Excel, and tap New. A blank workbook appears.
Or, if you have selected a template for new workbooks in the Options dialogue box, that
template appears with appropriate text and formatting already provided. You can open only one
workbook at a time. When you open a second workbook, you are asked to save the first. You
can save a workbook you create or edit in a variety of formats, including Pocket Excel (.pxl) and
Excel (.xls).



4-6  Use Companion Programs

Pocket Excel contains a list of the files stored on your Pocket PC. Tap a file in the list to open it.
To delete, make copies of, and send files, tap and hold a file in the list. Then select the
appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and
filtering. To display the toolbar, tap View and tap Toolbar.

Pocket Excel Screen

Note   If your workbook contains sensitive information, you can protect it with a password. To
do so, open the workbook, tap Edit, and tap Password. Every time you open the workbook, you
need to enter the password, so choose one that is easy for you to remember but hard for others
to guess.

Tips for Working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel.

 View in full-screen mode to see as much of your worksheet as possible. Tap View and tap
Full Screen. To exit full-screen mode, tap Restore.

 Show and hide window elements. Tap View and then tap the elements you want to show or
hide.

 Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View
and tap Freeze Panes. You might want to freeze the top and leftmost panes in a worksheet
to keep row and column labels visible as you scroll through a sheet.

 Split panes to view different areas of a large worksheet. Tap View and tap Split. Then drag
the split bar to where you want it. To remove the split, tap View and tap Remove Split.

 Show and hide rows and columns. To hide a hidden row or column, select a cell in the row
or column you want to hide. Then tap Format, tap Row or Column, and tap Hide. To show
a hidden row or column, tap Tools, tap Go To, and then type a reference that is in the
hidden row or column. When done, tap Format, tap Row or Column, and tap Unhide.

For more information on using Pocket Excel, tap  and tap Help.
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MSN Messenger
MSN Messenger on your Pocket PC is an instant messaging program that lets you

 see who is online

 send and receive instant messages

 have instant message conversations with groups of contacts.

To use MSN Messenger, you must have an Internet connection and a Microsoft Passport™
account or a Microsoft Exchange e-mail account. You must have a Passport to use MSN
Messenger Service. If you have a Hotmail or MSN account, you already have a Passport. Once
you have obtained either a Microsoft Passport or a Microsoft Exchange account, you can set up
your account.

Note   Sign up for a Microsoft Passport account at www.passport.com. Get a free Microsoft
Hotmail e-mail address at www.hotmail.com.

To switch to MSN Messenger, tap , tap Programs, and tap MSN Messenger.

Setting Up
Before you can connect, you must enter Passport or Exchange account information. Set up an
account and sign in as follows:

1. In the Tools menu, tap Options.

2. In the Accounts tab, enter your Passport or Exchange account information.

3. To sign in, tap the sign-in screen and enter your e-mail address and password.

Note   If you already use MSN Messenger on your desktop computer, your contacts show up
on your Pocket PC without being added again.
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Working with Contacts
The MSN Messenger window shows all of your messenger contacts at a glance, and are divided
into Online and Not Online categories. From this view, while connected, you can chat, send
e-mail, block the contact from chatting with you, or delete contacts from your list using the pop-
up menu.

MSN Messenger Contacts Screen

Note   To see others online without being seen, in the Tools menu, tap My Status and select
Appear Offline.

If you block a contact, it appears offline but remains on the blocked contact’s list. To unblock a
contact, tap and hold the contact, then tap Unblock on the pop-up menu.



Use Companion Programs  4-9

Chatting with Contacts
Tap a contact name to open a chat window. Enter your message in the text entry area at the
bottom of the screen, or tap My Text to enter a preset message, and tap Send. To invite another
contact to a multi-user chat, in the Tools menu, tap Invite and tap the contact you want to invite.

MSN Messenger Chat Screen

Note   To switch back to the main window without closing a chat, tap Contacts. To revert
back to your chat window, tap Chats and select the person whom you were chatting with.

To know if the contact you are chatting with is responding, look for the message under the text
entry area.

MSN Messenger Response Screen
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Windows Media Player for Pocket PC
Use Microsoft Windows Media Player for Pocket PC to play digital audio and video files that
are stored on your Pocket PC or on a network. To switch to Windows Media Player for Pocket
PC, tap  and tap Windows Media.

Windows Media Player Screen

Use Microsoft Windows Media Player on your desktop computer to copy digital audio and
video files to your Pocket PC. You can play Windows Media and MP3 files on your Pocket PC.

For more information about using Windows Media Player, tap , and tap Help.

Microsoft Reader
Use Microsoft Reader to read eBooks on your Pocket PC. Download books to your desktop
computer from your favourite eBook Web site. Use ActiveSync to copy the book files to your
activated Pocket PC. The books appear in the Reader Library, where you can tap them in the list
to open them.

Note   Before you can use Microsoft Reader, you must activate it from the Microsoft activation
site (das.microsoft.com/activate). Follow the directions given at the Microsoft site.

Each book consists of a cover page, an optional table of contents, and the pages of the book.
You can:

 Page through the book by using the scroll dial on your Pocket PC or by tapping the page
number on each page.

 Annotate the book with highlighting, bookmarks, notes, and drawings.

 Search for text and look up definitions for words.
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The Guidebook contains all the information you need to use the software. To open the
Guidebook, tap Help on the Reader command bar. Or, on a book page, tap and hold on the book
title, and then tap Help on the pop-up menu.

To switch to Microsoft Reader, tap , tap Programs, and tap Microsoft Reader.

Getting Books on Your Pocket PC
You can download book files from the Web. Just visit your favourite eBook retailer and follow
the instructions to download the book files.

Sample books and a dictionary are also included in the MSReader folder on the Companion CD.

Use ActiveSync to download the files from your desktop computer to your activated Pocket PC
as described in the Read Me file in the MSReader folder.

Using the Library
The Library is your Reader home page. The home page displays a list of all books stored on
your Pocket PC or storage card.

To open the Library:

 on the Reader command bar, tap Library

 on a book page, tap the book title, and tap Library on the pop-up menu.

To open a book, tap its title in the Library list.

Microsoft Reader Library Screen
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Reading a Book
Each book consists of a cover page, an optional table of contents, and the pages of the book.
Navigation options are listed in the bottom portion of the cover page.

The first time you open a book, you will probably want to go to the first page or to the table of
contents, if there is one. Subsequently, whenever you open the book, you automatically go to the
last page read.

In addition to the text, each book page includes a page number and book title.

Microsoft Reader Book Page

You can also page through a book by using the scroll dial on your Pocket PC.

Using Reader Features
Reading a book electronically gives you several options not available with paper books. These
options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the pop-up menu, as
described here.

 Search for Text. Find text in a book by tapping Find on the pop-up menu. Enter the word
you want to search for, and tap the desired Find option. Reader highlights found text on the
page. To close Find, tap outside the box. To return to your original page, tap the title and
then tap Return on the pop-up menu.

 Copy Text. You can copy text from books that support this feature into any program that
accepts text. On a book page, select the text you want to copy. Then, tap Copy Text on the
pop-up menu. The text can be pasted into the program of your choice.

 Bookmarks. When you add a bookmark to a book, a colour-coded bookmark icon appears in
the right margin. You can add multiple bookmarks to a book. Then, from anywhere in the
book, tap the bookmark icon to go to the bookmarked page.

 Highlights. When you highlight text, it appears with a coloured background.

 Notes. When you attach a note to text, you enter the text in a note pad that appears on top of
the book page. A Note icon displays in the left margin. To show or hide the note, tap the
icon.
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 Drawings. When you add a drawing, a Drawing icon appears in the bottom-left corner of
the page and drawing tools appear across the bottom of the page. Draw by dragging your
stylus.

 To see a list of a book’s annotations, including bookmarks, highlights, text notes, and
drawings, tap Annotations Index on the book’s cover page. You can tap an entry in the list
to go to the annotated page.

Removing a Book
When you finish reading a book, you can delete it to conserve space on your Pocket PC. If a
copy of the book is stored on your desktop computer, you can download it again at any time.

To remove a book from your Pocket PC, tap and hold the title in the Library list, and then tap
Delete on the pop-up menu.
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Use Microsoft Pocket Internet Explorer to view Web or Wireless Application Protocol (WAP)
pages in either of these ways.

 During synchronisation with your desktop computer, download your favourite links and
mobile favourites that are stored in the Mobile Favourites subfolder in Internet Explorer on
the desktop computer.

 Connect to an Internet Service Provider (ISP) or network and browse the Web directly from
your Pocket PC. To do this, you will need an optional modem or network card and you will
need to create the connection, as described in Chapter 6.

When connected to an ISP or network, you can also download files and programs from the
Internet or intranet.

To switch to Pocket Internet Explorer, tap  and tap Internet Explorer.

Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favourites and channels that have been
downloaded to your Pocket PC without connecting to the Internet. You can also connect to the
Internet through an ISP or a network connection and browse the Web.

View Mobile Favourites and Channels
You can easily view mobile favourites and channels with your Pocket PC.

1. Tap the Favourites button to display your list of favourites.

2. Tap the page you want to view.

Viewing Favourites

You will see the page that was downloaded the last time you synchronised with your desktop
computer. If the page is not on your Pocket PC, the favourite is dimmed. You need to
synchronise with your desktop computer again to download the page to your Pocket PC, or
connect to the Internet to view the page.
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Browse the Internet
You can browse the Internet with your Pocket PC. Here’s how.

1. Set up a connection to your ISP or corporate network using Connections, as described in
Chapter 6.

2. To connect and start browsing, do one of the following:

 Tap the Favourites button, and then tap the favourite you want to view.

 Tap View and tap Address Bar. In the address bar at the top of the screen, enter the
Web address you want to visit and then tap Go. Tap the arrow to choose from
previously entered addresses.

Note   To add a favourite link while using the Pocket PC, go to the page you want to add, tap
and hold on the page and tap Add to Favourites.

Mobile Favourites Folder
Only items stored in the Mobile Favourites subfolder in the Favourites folder in Internet
Explorer on your desktop computer are synchronised with your Pocket PC. This folder was
created automatically when you installed ActiveSync.

Favourite Links
During synchronisation, the list of favourite links in the Mobile Favourites folder on your
desktop computer is synchronised with Pocket Internet Explorer on your Pocket PC. Both
computers are updated with changes made to either list each time you synchronise. Unless you
mark the favourite link as a mobile favourite, only the link is downloaded to your Pocket PC,
and you need to connect to your ISP or network to view the content. For more information on
synchronisation, see ActiveSync Help on the desktop computer.

Mobile Favourites
If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can
download mobile favourites to your Pocket PC. Synchronising mobile favourites downloads
Web content to your device so that you can view pages while you are disconnected from your
ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favourites quickly.

Creating a Mobile Favourite
Create a mobile favourite as follows:

1. In Internet Explorer on your desktop computer, click on Tools and click on Create Mobile
Favourite.

2. To change the link name, enter a new name in the Name box.

3. Optionally, in Update, select a desired update schedule.

4. Click on OK. Internet Explorer downloads the latest version of the page to your desktop
computer.

5. If you want to download the pages that are linked to the mobile favourite you just created,
in Internet Explorer on the desktop computer, right-click on the mobile favourite and click
on Properties. In the Download tab, specify the number of links deep you want to
download. To conserve memory, go only one level deep.
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6. Synchronise your Pocket PC and desktop computer. Mobile favourites that are stored in the
Mobile Favourites folder in Internet Explorer are downloaded to your Pocket PC.

Note   If you did not specify an update schedule in step 3, you need to manually download
content to keep the information updated on your desktop computer and Pocket PC. Before
synchronising with your Pocket PC, in Internet Explorer on your desktop computer, click on Tools
and click on Synchronise. You will see the last time content was downloaded to the desktop
computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favourites. In Internet
Explorer on your desktop computer, click on View, click on Toolbars, and click on Customise.

Saving Pocket PC Memory
Mobile favourites take up storage memory on your Pocket PC. To minimise the amount of
memory used:

 In the settings for the Favourites information type in ActiveSync options, turn off pictures
and sounds, or stop some mobile favourites from being downloaded to the Pocket PC. For
more information, see ActiveSync Help.

 Limit the number of downloaded linked pages. In Internet Explorer on the desktop
computer, right-click on the mobile favourite you want to change and click on Properties.
In the Download tab, specify 0 or 1 for the number of linked pages you want to download.

AvantGo Channels
AvantGo is a free interactive service that gives you access to personalised content and thousands
of popular Web sites. You subscribe to AvantGo channels directly from your Pocket PC. Then,
you synchronise your Pocket PC and desktop computer, or connect to the Internet to download
the content. For more information, visit the AvantGo Web site (avantgo.com).

Sign up for AvantGo
Sign up for the free AvantGo service as follows:

1. In the ActiveSync options on the desktop computer, turn on synchronisation for the
AvantGo information type.

2. In Pocket Internet Explorer on your Pocket PC, tap the Favourites button to display your
list of favourites.

3. Tap the AvantGo Channels link.

4. Tap the Activate button.

5. Follow the directions on the screen. You will need to synchronise your Pocket PC with your
desktop computer and then tap the My Channels button to complete the AvantGo Setup.

When synchronisation is complete, tap the AvantGo Channels link in your list of favourites to
see a few of the most popular channels. To add or remove channels, tap the Add or Remove
link.
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You can use your Pocket PC to exchange information with other mobile devices as well as your
desktop computer, a network, or the Internet. You have the following connection options.

! Use the IR port on your Pocket PC to send and receive files between two devices. If this is
the method you want to use, see the following section “Transfer Items Using Infrared.”

Note   Check with your Internet Service Provider (ISP) to see if the ISP supports receiving e-
mail on your Pocket PC.

! Connect to your ISP. Once connected, you can send and receive e-mail messages by using
Inbox and view Web or WAP pages by using Microsoft Pocket Internet Explorer. The
communication software for creating an ISP connection is already installed on your Pocket
PC. Your service provider should provide software needed to install other services, such as
paging and fax services. If this is the method you want to use, see “Connect to the Internet”
later in this chapter.

! Connect to the network at your company or organisation where you work. Once connected,
you can send and receive e-mail messages by using Inbox, view Web or WAP pages by
using Pocket Internet Explorer, and synchronise with your desktop computer. If this is the
method you want to use, see “Connect to Work” later in this chapter.

! Connect to your desktop computer to synchronise remotely. Once connected, you can
synchronise information such as your Pocket Outlook information. If this is the method you
want to use, see ActiveSync Help on your desktop computer or Connections Help on the
Pocket PC.

Transfer Items Using Infrared
With the Pocket PC, you can send and receive data to and from another similarly equipped
device using the IR communication port. In addition, you can use the IR port to synchronise data
with your desktop computer, in place of using the synchronising cable.

Using infrared (IR), you can send and receive information, such as contacts and appointments,
between two devices.

Send Information
Send information as follows:

1. Switch to the program where you created the item you want to send and locate the item in
the list.

2. Position the Pocket PC and the second device so that the IR ports face each other. Position
the devices within 5 to 50 centimetres apart. You might want to remove the Pocket PC
cover so that it does not block the IR port (see Chapter 1).

Note   If the units are too far apart or if something blocks the path between the two ports, data
might not be sent or received correctly.

3. Be sure that nothing obstructs the path between the IR ports on both devices, and that the
ports are aligned properly.

4. Tap and hold the item, and tap Beam Item on the pop-up menu.

Note   You can also send items, but not folders, from File Explorer. Tap and hold the item you
want to send, and then tap Beam File on the pop-up menu.
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Receive Information
Receive information as follows:

1. Align the IR ports on the two devices so that they are unobstructed and within 5 to 50
centimetres apart.

2. Have the owner of the other device send the information to you. Your Pocket PC
automatically receives it.

Connect to the Internet
You can connect to your ISP, and use the connection to send and receive e-mail messages and
view Web or WAP pages.

You can connect to work in one of two ways:

! Create a modem connection. If this is the method you want to use, see “Create a Modem
Connection to an ISP.” You need an optional modem card and an optional CF/PC Card
expansion jacket to do this.

! Use an Ethernet card and a net tap to connect to the network. If this is the method you want
to use, see “Create an Ethernet Connection to an ISP.”

Create a Modem Connection to Your ISP
Create a modem connection to your ISP as follows:

1. Obtain the following information from your ISP: ISP dial-up access telephone number, user
name, password, and TCP/IP settings. Some ISPs require information in front of the user
name, such as MSN/username.

2. If your Pocket PC does not have a modem, install an optional modem.

3. Tap  and tap Settings. In the Connections tab, tap Connections. Under The Internet
settings, select Internet Settings and tap Modify.

4. In the Modem tab, tap New.

5. Enter a name for the connection, such as “ISP Connection.”

6. In the Select a modem list, select your modem type. If your modem type does not appear,
try re-inserting the modem card.

7. You should not need to change any settings in Advanced. Most ISPs now use a
dynamically-assigned address. If the ISP you are connecting to does not use a dynamically-
assigned address, tap Advanced and tap TCP/IP tab, and enter the address. When finished,
tap OK and tap Next.

8. Enter the access phone number, and tap Next.

9. Select other desired options, and tap Finish.

10. In the Dialling Locations tab, specify your current location and phone type (most phone
lines are tone). These settings apply to all connections you create.

11. To start the connection, start using one of the following programs. Your Pocket PC
automatically begins connecting. Once connected, you can:

! Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need
to provide the information it needs to communicate with the e-mail server. For specific
instructions, see “Connect Directly to an E-mail Server,” later in this chapter.
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! Visit Web and WAP pages by using Pocket Internet Explorer. For more information,
see Chapter 5.

! Send and receive instant messages with MSN Messenger. For more information, see
“MSN Messenger” in Chapter 5.

Create an Ethernet connection to an ISP
Create an Ethernet connection to your ISP as follows:

1. You do not need to create a new connection on your Pocket PC. Instead, you need an
Ethernet card and CF/PC Card expansion jacket for your Pocket PC.

2. Obtain a user name, password, and domain name from your ISP.

3. Install the Ethernet card on your Pocket PC. For instructions on installing and using the
Ethernet card, see the owner’s manual for the card.

4. The first time you install the card, Network Settings appears automatically so that you can
configure the Ethernet card. Most networks use DHCP, so you should not have to change
these settings unless your network administrator instructs you to do so. Tap OK. (If it does
not appear or to change settings later, tap  and tap Settings. In the Connections tab, tap
Network, tap the adapter you want to change, and tap Properties.)

5. Connect the Ethernet card to the network with a network cable. For more information, see
the owner’s manual for the card.

6. Tap , tap Settings, tap the Connections tab, and tap Connections. From the My
network card connects to list, select Internet.

To start the connection, start using one of the programs listed in the preceding section. Once
connected, you can perform the same activities as listed in the preceding section.

Connect to Work
If you have access to a network at work, you can send e-mail messages, view intranet pages,
synchronise your Pocket PC, and possibly access the Internet. You can connect to work in one
of two ways:

! Create a modem connection by using a Remote Access Services (RAS) account. Before you
can create this modem connection, your network administrator needs to set up a RAS
account for you. If this is the method you want to use, see “Create a Modem Connection to
a Network.” Your network administrator might also give you Virtual Private Network
(VPN) settings.

! Use an optional Ethernet card and a net tap to connect to the network. If this is the method
you want to use, see “Create an Ethernet Connection to a Network.”

Create a Modem Connection to a Network
Create your modem connection to a network as follows:

1. Get the following information from your network administrator:

! dial-up access telephone number

! user name and password

! domain name and TCP/IP settings.
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2. Install an optional modem card.

3. Tap  and tap Settings. In the Connections tab, tap Connections. Under The Internet
settings, select Internet Settings and tap Modify.

4. In the Modem tab, tap New.

5. Enter a name for the connection, such as “Company Connection.”

6. In the Select a Modem list, select your modem type. If your modem type does not appear,
try reinstalling the modem card.

7. You should not need to change any settings in Advanced. Most servers now use a
dynamically-assigned address. If the server you are connecting to does not use a
dynamically-assigned address, tap Advanced, tap the TCP/IP tab, and enter the address.
When finished, tap OK and tap Next.

8. Enter the access phone number, and tap Next.

9. Select other desired options, and tap Finish.

10. In the Dialling Locations tab, specify your current location and phone type (most phone
lines are tone). These settings apply to all connections you create.

To start the connection, use one of the following programs. Your Pocket PC automatically
begins connecting. Once connected, you can:

! Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need to
provide the information it needs to communicate with the e-mail server. For specific
instructions, see “Connect Directly to an E-mail Server,” later in this chapter.

! Visit Internet or intranet Web or WAP pages by using Pocket Internet Explorer.

! Send and receive instant messages with MSN Messenger. For more information, see “MSN
Messenger” in Chapter 5.

! Synchronise. For more information, see ActiveSync Help on the desktop computer.

Create an Ethernet Connection to a Network
Create an Ethernet connection to a network as follows:

1. You do not need to create a new connection on your Pocket PC. You need an optional
Ethernet card and CF/PC Card expansion jacket for your Pocket PC.

2. Get a user name, password, and domain name from your network administrator.

3. Install the Ethernet card on your Pocket PC. For instructions on installing and using the
Ethernet card, see the owner’s manual for the card.

4. The first time you install the card, Network Settings appears automatically so that you can
configure the Ethernet card. Most networks use DHCP, so you should not have to change
these settings unless your network administrator instructs you to do so. Tap OK. (If it does
not appear or to change settings later, tap  and tap Settings. On the Connections tab,
tap Network, tap the adapter you want to change, and tap Properties.)

5. Connect the Ethernet card to the network with a network cable. For information, see the
owner’s manual for the card.

6. Tap , tap Settings, tap the Connections tab, and tap Connections. From the My
network card connects to list, select Work.
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7. If you want to synchronise your Pocket PC, tap , and tap ActiveSync. In the Tools
menu, tap Options. In the PC tab, select Include PC when synchronising remotely and
connect to, and select your computer's name.

Remote synchronisation with a desktop computer works only if you set up a partnership
with that computer through ActiveSync and have set ActiveSync to allow remote
connections. Other restrictions apply. For more information on synchronising remotely, see
ActiveSync Help on the desktop computer.

To start the connection, use one of the programs listed in the preceding section. Once connected,
you can perform the same activities as listed in the preceding section.

End a Connection
To end a connection, do one of the following:

! When connected via dial-up or VPN, tap the Connection icon  on the navigation bar, and
tap End.

! When connected via Infrared, move the Pocket PC away from the desktop computer.

! When connected via a network (Ethernet) card, remove the card from your Pocket PC.

Connect Directly to an E-mail Server
You can set up a connection to an e-mail server so that you can send and receive e-mail
messages by using an optional modem or network card and Inbox on your Pocket PC.

Note   The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway.

You can use multiple e-mail services to receive your messages. For each e-mail service you
intend to use, first set up and name the e-mail service. If you use the same service to connect to
different mailboxes, set up and name each mailbox connection.

Set up an E-mail Service
In Inbox on your Pocket PC, tap Services, and tap New Service. Follow the directions in the
New Service wizard.

For an explanation of a screen, tap  and tap Help. When finished, to connect to your e-mail
server, tap Services and tap Connect. For more information on using the Inbox program, see
“Inbox: Sending and Receiving E-mail Messages” in Chapter 4.

Get Help on Connecting
More information on the procedures described here, as well as information on additional
procedures, can be found in the following locations.

! “Inbox: Sending and Receiving E-mail Messages” in Chapter 4.

! Online Help on the Pocket PC. Tap  and tap Help. Tap View, tap All Installed Help, and
tap Inbox or Connections.

! ActiveSync Help on the desktop computer. In ActiveSync, click Microsoft ActiveSync
Help on the Help menu.

! For troubleshooting information, see the Pocket PC Web site at:
www.microsoft.com/mobile/pocketpc.
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You may occasionally encounter a problem with your Pocket PC. In most cases, the problem is
one that you can solve yourself.

If there is a problem, the Pocket PC may display an error message. If this happens, follow any
instructions on the screen.

If screen messages do not help or an error message does not appear, refer to the information in
this chapter to help determine and solve the problem.

Problem Solving
When trying to solve problems, you should note what the Pocket PC was doing when the
problem occurred and what you attempted to do to correct the problem. This information is
useful if you request assistance.

See the following table to match your problem area and view what to do.

Problem Solving
Problem What to Do

No display 1. Press the power button.
2. Recharge the battery.
3. Check the backlight and brightness settings.
4. Soft reset the Pocket PC. If possible, save your data then
use the stylus to press and hold in the reset button for several
seconds.

Display dark or hard to read 1. Turn on the backlight.
2. Adjust the backlight setting.
3. Adjust the brightness setting.
4. Use the Zoom tool or Text Size tool to enlarge text.

Unit responds slowly or
erratically

1. Recharge the battery.
2. Soft reset the Pocket PC. If possible, save your data then
use the stylus to press and hold in the reset button for several
seconds.

Unit stops responding or
locks up

1. Soft reset the Pocket PC. If possible, save your data then
use the stylus to press and hold in the reset button for several
seconds.
2. Recharge the battery.
3. Hard reset to factory settings (see “Hard Reset” later in this
chapter).

CAUTION, all your data is lost when you perform a hard reset.

Battery power low or does
not last long

1. Recharge the battery.
2. Use external power as much as possible.
3. Shorten the auto-suspend time.
4. Adjust the backlight and brightness settings to a lower
value.
5. Turn off sounds not needed.

Storage or program memory
low or unavailable

1. Close all unnecessary programs and tasks.
2. Move data to a storage card.
3. Set programs to save to a storage card.
4. Remove programs you no longer use.
5. Adjust the slider in memory settings allocation.
6. Soft reset the Pocket PC.
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Problem Solving
Problem What to Do

Touch screen does not
respond

1. Calibrate the touch screen (see Chapter 1).

AC Adapter doesn’t work 1. Check that all connections are secure.
2. Check that the AC outlet is working.

Cradle doesn’t work 1. Check that all connections and cables are secure and
correct for the task being performed.
2. Check that the Pocket PC is securely seated in the cradle.

Hard Reset

Save your data to a memory card or to your computer before doing a
hard reset. All your data is lost when you do a hard reset.

1. Disconnect all cables from your Pocket PC.

2. Remove the battery by sliding the battery lock to the left (see “Install and Charge the
Battery” in Chapter 1).

3. Slide the hard reset switch to the left.

4. Wait for 1 minute and then slide the switch back to the right.

5. Replace the battery.

6. Press the power button to power on the Pocket PC.

7. Tap the touch screen to start the calibration and activation.
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Help Resources
If the problem you are experiencing cannot be solved, you might want to try the following help
resources.

Help Resources
Item Resource

Windows Pocket PC Windows Pocket PC Help
Help file included with Windows Pocket PC. Tap Start on the
“Today” screen, tap Help on the “Programs” screen, and tap
an item on the “Help Contents” screen.

Windows Pocket PC web site
www.microsoft.com/mobile/pocketpc/
howdoi/default.asp

ActiveSync ActiveSync Help on your computer
After installing ActiveSync on your computer, click on
Start/Programs/ActiveSync to open the ActiveSync window.
Select Help from the menu bar and click on Microsoft
ActiveSync Help.

ActiveSync Help on your Pocket PC
Tap  at the “Today” screen and tap Help on the Navigation
Bar. At the “Help Contents” screen, tap Connections. At the
“Connections Help” screen, tap a help topic.

ActiveSync Help on the Web
www.microsoft.com/mobile/pocketpc/
howdoi/default.asp

Pocket Word, Excel,
Reader, Outlook (Inbox,
Calendar, Contacts, Tasks,
Notes), Windows Media
Player, Internet Explorer

Microsoft Pocket PC Features
www.microsoft.com/mobile/pocketpc/
bguide/features/mobile_software.asp
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The following specifications are standard except where noted.

System Specifications
Display

64K colour, 240 x 320 pixels, TFT, liquid crystal display (LCD), with backlight, touch screen

CPU

Intel Strong ARM, 206-MHz processor

User Data Entry Methods

 Touch screen (input via stylus)

 Scroll (Jog) dial

 Soft keyboard

 Block recognizer

 Letter recognizer

 Transcriber

Read Only Memory (ROM)

32 megabytes (MB)

Synchronous Dynamic Random Access Memory (SDRAM)

64 megabytes (MB)

Speaker

One built-in speaker

Infrared (IrDA) Communication

 Data transfer rate - up to 115.2 kb per second

 Distance - 5 to 20 centimetres

Pocket PC I/O Ports

 IrDA port

 Headset jack

 Expansion port

 Power port (DC in)

USB Cradle

 USB PC connect cable

 Power port (DC in)

Card Slots

One Secure Digital (SD)/Multimedia Memory Card (MMC) slot
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Backlighting

 Automatic

Power

 AC Adapter

— Input Voltage - 100 to 240 volts AC, 50 or 60 Hz

— Output Voltage - 5.0 volts, 3.0 amp

 Battery - One rechargeable Lithium-Ion (Li-Ion) 1000 mAh battery (included)

Power Management

 Low battery power detection

— Less than 50 % (battery low warning)

— Less than 10 % (battery very low warning)

— Less than 0 % (battery depleted, unit powers off)

Data Protection

 SDRAM data preserved for 72 hours after battery depleted

Accessories (shipped with Pocket PC)

 Battery

 AC adapter with European and UK converters

 USB cradle

 Stylus (one stored on Pocket PC and one bundled with the cradle)

Physical Specifications
Dimensions (approximate)

 4.92 in. (h) x 3.02 in. (w) x 0.58 in. (d)

 125 mm (h) x 76.8 mm (w) x 14.8 mm (d)

Weight (approximate)

 5.15 oz. (with battery)

 146 grams (with battery)

Environment Specifications
Operating Environment

 Temperature - 32º to 104ºF (0º to 40ºC)

 Humidity - 20% to 90% (Non condensing)

Storage Environment

 Temperature - 14º to 140ºF (–10º to 60ºC)

 Humidity - 20% to 90% (Non condensing)
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Regulatory Information

European Notice

Products with the CE marking comply with both the Electromagnetic Compatibility Directive (89/336/EEC) and the Low
Voltage Directive (72/23/EEC) - modified by the Directive 96/68/ECC - issued by the Commission of the European
Community.

Compliance with these directives implies conformity to the following European Standards:

EN55022: Radio disturbance characteristics
EN55024: Immunity characteristics
EN6100-3-2: Limits for harmonic current emissions
EN6100-3-3: Limitation of voltage fluctuation and flicker in low-voltage supply system
EN60950 : Product Safety

Modifications to the Product
CE Marking

NEC Computers International cannot be held responsible for modifications made by the User and the consequences
thereof, which may alter the conformity of the product with the CE Marking.

Radio Frequency Interference

The manufacturer is not responsible for any radio or TV interference caused by unauthorised modifications to this
equipment.

Battery Replacement
A Lithium Ion battery in this computer maintains system configuration information. In the event that the battery fails to
maintain system configuration information, we recommend that you call your local NEC or Packard Bell dealer. The
battery is not user replaceable.

WARNING  This unit contains a non-replaceable internal Lithium Ion battery. To reduce the risk of fire or burns, do
not disassemble, crush, puncture, or dispose of in fire or water.

Contact your local waste management officials for other information regarding the environmentally sound collection,
recycling, and disposal of used batteries.
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